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Navigating Networks: The Navigating Networks Interface 

The Navigating Networks service provides an interactive interface for exploring and 
analysing networks of artistic collaborations in the AusStage database.  

Network visualisation and analysis can reveal patterns of collaboration between 
artists that have previously been unrepresentable using conventional text-based 
displays. This service presents existing data in new ways, allowing researchers to 
interrogate the collaborations that underpin creativity in the performing arts.  

The home page for the Aus-e-Stage Navigating Networks interface (Figure 1) is at: 
http://beta.ausstage.edu.au/networks/  

 

Figure 1: The Navigating Networks home page 

Note: The web interface for browsing networks uses the Protovis toolkit for 
visualisation and will only work in up-to-date browsers, such as Safari 5.x, Firefox 
3.6x and Google Chrome 6.x.  

Navigating Networks: Terms and Concepts  

Networks represents things and their relationships. A network is visualised as set of 
things linked by lines representing their relationships. Network visualisations are 
sometimes called graphs. The things that make up a network are referred to as 
nodes; nodes are also sometimes called vertices or points. The relationships in a 
network graph are referred to as links; links are sometimes called edges or lines.  

In AusStage, we focus on relationships between contributors and events. A 
contributor is an individual, usually a person, who contributes in some capacity to the 
conception, production or presentation of an event. An event is a distinct happening 
defined by title, date/s and venue; typically, a performance or series of performances 
at a venue. There are two ways we can look at the relationship between contributors 
and events. 

Contributor network: We can visualise a network of contributors linked by the 
events they have collaborated on. A contributor network is centred on one 
contributor. It shows all the contributors who have collaborated with the central 
contributor, and all of their collaborations with each other. 
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Event network: We can also visualise a network of events linked by their 
contributors. An event network is centered on one event. It shows the events that 
contributors were working on before and after the central event.  

Navigating Networks: Emergent Principles 

A set of principles emerged during our research on networks in AusStage. These 
principles guided the development of the network interface. 

A focus on artistic networks 

While it is possible to use network analysis to visualise various relationships between 
different entities (organisations, events, venues, genres and so on), our focus is on 
the artistic networks articulated through the relationships between contributors and 
events. There is a realism to this focus which reflects the collaborative ethic of the 
performance arts and the obligations of co-presence in the rehearsal room. 

An awareness of complexity 

The AusStage contributor network is large and complex. At June 2010, it comprised 
1,634,088 relationships between 76,488 contributors. Visualisation efforts using 
dedicated software have succeeded in working on relatively small sub-networks 
(<20,000 edges, <2,000 nodes) constrained by contributor, or by association with a 
venue or organisation. Visualising networks for display in web browsers imposes 
additional constraints. 

The necessity of focus+context 

Our experience in using network visualisation for analysis is characterised by 
zooming in and out – zooming in to focus on particular artists and relationships, and 
zooming out to grasp their position within the larger network. This experience is 
addressed by the interface principle of focus-plus-context (see http://www.infovis-
wiki.net/index.php/Focus-plus-Context). 

An interest in quality 

Researchers are interested in articulating the significance and quality of artistic 
collaborations. While these interests imply qualitative research, there are three 
aspects of data available in AusStage which could assist researchers in identifying 
quality and significance of a relationship between two or more artists: the number of 
their collaborations, the frequency of their collaboration over time (and changes in the 
frequency), and their respective roles (and again, changes in roles over time). 

The significance of time 

The networks of artistic collaboration in the AusStage dataset are dynamic. They are 
time-coded by event and they change over time. Experiments in analysing network 
dynamics in the AusStage data suggest patterns of branching and consolidation, 
transitions in centrality, and sequences of growth, consolidation, release and 
reorganisation (Walker and Salt 2006). But approaches to analysing dynamic 
networks are at the leading edge of the field. Refining techniques for visualisation, 
including timelines, animation and 3D, will entail experimentation. 
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Navigating Networks: Search 

The search page for the Aus-e-Stage Navigating Networks interface (Figure 2) is at 
http://beta.ausstage.edu.au/networks/networks.html 

 

Figure 2: The Navigating Networks interface 

The Navigating Networks search retrieves contributors and events that match all your 
search terms. Type double quotation marks (“”) around search terms for exact phrase 
searching.  

Records with matching alternate or previous names will also be retrieved. Please 
wait for the search to complete before exploring the results.  

A maximum of 25 results will retrieved for each type of record. If you don't see what 
you are looking for, try refining your search terms. You could also try searching the 
main AusStage website.  
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Example Search 

A search for “martha”, for example, results in matches with 17 contributors and 23 
events, as shown with results expanded in the figure below. From your search 
results, you can browse either a contributor network or an event network.  

 

 

Figure 3: Navigating Networks Search for “martha” 
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Links to AusStage records 

You may click on the Contributor or Event name on the search results screen to view 
the record in AusStage, as shown in the example in Figure 4.  

 

Figure 4: Contributor record link to AusStage record 

Search History 

Search history is available on the Navigating Networks Search History tab. Use this 
function to return to previous current session search results for viewing and re 
creating network graphics as desired. This option is located at the bottom of the 
search interface page as shown in Figure 11.  

 

Figure 11: Navigating Networks Search History 
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Navigating Networks: Contributor Networks 

A contributor network is centred on the selected contributor. It shows all the 
contributors who have collaborated with the central contributor, and all of their 
associations with each other.  

To view a contributor network: 

1. Click the + icon to select a contributor. Your selection is added beneath the 
contributor search results. You can click the x next to the contributor name to 
remove the contributor and make another selection. 

2. Click the View Network button to see the network.  

Retrieving network data 

The underlying network data is often complex and may take a little time to process. 
Please be patient and allow time for the interface to retrieve data. A message is displayed 
while retrieving network data. 

 

Figure 5: Retrieving network data message 

Example Contributor Network 

Figure 6 selects Martha Ibrahim from the “martha” search results to illustrate viewing 
a contributor network. 
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Figure 6: Selecting contributor Martha Ibrahim and viewing her contributor network 

Navigating Networks: Contributor Network Display  

In a contributor network, contributors are represented as round nodes. Larger nodes 
represent contributors who have worked with more contributors in the network. Smaller 
nodes represent contributors who have worked with fewer contributors in the network.  

Collaborations between contributors are represented as lines. Thicker lines link 
contributors who have worked with each other on many events. Thinner lines link 
contributors who have worked with each other on fewer events. 

Manipulate the network graphic using a mouse or trackpad. Reveal contributors names 
by hovering the pointer over nodes and lines. Re-arrange the network layout by clicking 
and dragging nodes.  

Click on a contributor to select it. The selected contributor is coloured blue. Contributors 
who have collaborated with the selected contributor are coloured dark grey. Other 
contributors who have not directly collaborated with the selected contributor are coloured 
light grey.   

Click on a line to select the relationship between two contributors. The selected 
relationship is coloured blue. Only one contributor or one relationship may be selected at 
a time. 

Zoom in and out of the network by using the mouse scroll-wheel. Pan the whole network 
by clicking and dragging in space around the network.  

Information about the network is displayed in the sidebar to the left. Controls for adjusting 
the display and saving the network are also provided. 



  

12/06/11 - 11 - Navigating Networks 

Display  

Change the way information is displayed in the network graphic by adjusting the options 
in the Display tab. 

 

Label Display 

Show all contributor names: Check to display the names of all contributors in the network. 
Uncheck to hide all contributor names (see Figure 7). 

Show related contributor names: Check to display only the names of contributors who 
have collaborated with the selected contributor. Show all contributor names must be 
unchecked. 

Node Display 

Show all contributors: Check to display the nodes of all contributors in the network. 
Uncheck to hide all contributor nodes.  

Show related contributors: Check to display only the nodes of contributors who have 
collaborated with the selected contributor. Show all contributors must be unchecked. 

Edge Display 

Show all collaborations: Check to display the lines of all collaborations in the network. 
Uncheck to hide all collaborations. 

Show related collaborations: Check to display only the collaborations involving the 
selected contributor. Show All Collaborations must be unchecked. 

Min and max collaborations displayed: Use the slider to adjust the display of lines. Lines 
representing collaborations on a number of events that fall within the range are displayed. 
Lines representing collaborations a number of events that fall outside the range are 
hidden.   
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Custom Colours and Visibility 

You can customise the display of individual nodes. Click on a node while holding down 
the ALT key (also called OPTION key on Mac). From the pop-up window you can: colour 
the node by selecting from the palette, remove a custom colour you have previously 
applied, and temporarily hide the node and its lines.  

You can adjust the display of custom colours and hidden elements from the sidebar. 

Show Custom Colours: Check to display the custom colours applied to nodes. Uncheck to 
view the default colours of hide the custom colours, uncheck the box. To remove all 
custom colours permanently click the corresponding Reset button. 

Show Hidden Elements: Check to see elements that are individually hidden. Uncheck to 
hide all elements that are individually hidden. You can also use the corresponding Reset 
button to remove all customized hiding of elements. 

Time Slider 

Use the time slider beneath the network graphic to adjust the display of contributors and 
their collaborations by date. Only contributors who worked on events with first dates within 
the range will be displayed. Contributors whose collaborations on events with first dates 
outside the range are hidden. 

 

 

Figure 7: Network graphic with ‘show all contributor names’ display option selected 
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Save 

Download the network in GraphML format for viewing in a network visualisation 
application such as Gephi or Visone. The file will include all information in the 
network, regardless of the current display options. Information on how to view 
exported graph data is provided later in this manual. 

Network 

View information about the contributor network under the Network tab in the sidebar. 

 

Centre: The contributor at the centre of the network. Click on the Centre button to select 
the contributor. Click on the contributor's name to link to the AusStage record. 

Contributors: The number of contributors in the network including the central contributor. 
The central contributor's number of collaborators is this number minus one. For example, 
Martha Ibrahim has 85 - 1 = 84 collaborators. 

Relationships: The number of relationships between contributors in this network. A 
relationship is counted just once, even when two contributors have collaborated on two or 
more events. 

Collaborations: The number of collaborations between contributors in this network. A 
collaboration is counted each time two contributors have collaborated on an event. 



 

 

Contributor Details 

 

 

 

Information about a selected contributor is displayed 
in the sidebar. 

Click on a contributor's node in the network graphic 
to view information about the contributor. 

Click the triangle next to the contributor’s name in 
the sidebar to view the list of collaborators. 

Click on a contributor's name in the sidebar to link to 
the contributor's record in AusStage. 

 

Relationship Details 

 

Information about a selected relationship is also 
displayed in the sidebar 

Click on a line between two contributors in the 
network graphic to view information about their 
collaborations.  

Click on the triangle next to their names in the 
sidebar to view the events they have collaborated 
on. 

Click on the contributors' names in the sidebar to 
link to their records in AusStage.  
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Facets 

Use facets to highlight contributors in the network by artistic function, gender and 
nationality. Click on the Facets tab to browse these attributes. In facets mode, the 
background of the network graphic is coloured dark grey and selected nodes and lines 
are coloured white. Close the Facet tab to return to the regular mode. 

Select the attributes you want to highlight within each facet. The attributes are dynamically 
generated from the contributors in the network. The selected attributes are summarised in 
the Search Criteria tab.  

Show All Nodes: Check to display all nodes and relationships. Nodes matching those 
attributes are coloured blue. Uncheck to display only those nodes matching the selected 
attributes. All other nodes and their relationships are hidden. 

Figure 8 demonstrates how facets can highlight Actors who are Female and Australian in 
the ‘Martha Ibrahim’ network. 

 

Figure 8: Network graphic in Facets mode 



  

12/06/11 - 16 - Navigating Networks 

Navigating Networks: Event Networks  

An event network is arranged chronologically to show the events that contributors are 
involved in before and after the central event. There are three types of event network, 
which reveal a progressively broader and more complex picture of who was 
collaborating on what around the central event.  

• First Degree (default) retrieves a network that includes, for each contributor 
to the central event, their links to one event before and one event after the 
central event. 

• Second Degree Simple retrieves a network that includes, for each 
contributor to the central event, their links to two events before and two 
events after the central event.  

• Second Degree Complex retrieves a network which includes, for each 
contributor to the central event, their links to events before and after (first 
degree), and then, for each contributor to all those events, all their links to 
events before and after (second degree). 

The difference between the two types of networks at the second degree is this: for 
the simple network, we only retrieve the events at the second degree if they involved 
contributors to the central event; for the complex network, we retrieve all events at 
the second degree which involve contributors from events at the first degree. 

To view an event network: 

1. Click the + icon to select an event. Your selected event is added beneath the 
search results. Only one event can be selected for an event network. You can 
click the x next to the event name to remove the event and make another 
selection. 

2. Choose a network type from the drop-down menu. Choose either 1st Degree, 
2nd Degree Simple or 2nd Degree Complex. 1st Degree is the default. 

3. Click the View Network button to see the network.  

Example Event Network 

The event titled “The Under Room” held at the Bakehouse Theatre in Adelaide on 29 
October 2009 is chosen as the central event for this example. Enclose "The Under 
Room" in double quotation marks when performing the search. 

 

Figure9 illustrates the difference between First Degree, Second Degree Simple and 
Second Degree Complex network graphics.  
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First Degree Network 

 

Second Degree Network – Simple 

 

Second Degree Network – Complex 

 

Figure 9: First, Second-Simple and Second-Complex Network graphics for “The Under Room” 
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Navigating Networks: Event Network Display 

In an event network, events are represented as round nodes arranged chronologically by 
first date along a timeline. Contributors are represented as lines linking their events in 
chronological order. Larger nodes represent events with contributors linked to many other 
events in the network. Smaller nodes represent events with fewer contributors to other 
events.  

Manipulate the network graphic using a mouse or trackpad. Reveal the names of events 
by hovering the pointer over nodes. Reveal the names of contributors by hovering the 
pointer over lines. Re-arrange the network layout by clicking and dragging nodes. Nodes 
may only be dragged up-and-down; the horizontal position represents the event’s first 
date and this remains fixed to the timeline. 

Click on an event to select it. The selected event is coloured blue. Events linked by 
contributors before and after the selected event are coloured dark grey. Other events not 
directly connected with contributors to the selected event are coloured light grey.   

Click on a line to select a contributor’s path through a series of events. The selected 
contributor is coloured blue. Only one event or contributor may be selected at a time. 

Zoom in and out of the network by using the mouse scroll-wheel. Pan the whole network 
by clicking and dragging in space around the network.  

Information about the network is displayed in the sidebar to the left. Controls for adjusting 
the display and saving the network are also provided. 

Display 

Change the way information is displayed in the network graphic by adjusting the 
options in the Display tab. 

 

 

 

 

 

Label Display 

Show all contributor names: Check to display the names of all contributors in the network. 
Uncheck to hide all contributor names (see Figure 10). 
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Show related contributor names: Check to display only the names of contributors who 
have collaborated with the selected contributor. Show all contributor names must be 
unchecked.  

Show all event names: Check to display the names of all events in the network. Uncheck 
to hide all event names. 

Show related event names: Check to display the names of events linked by contributors 
to the selected event. Show all event names must be unchecked. 

Node Display 

Show all events: Check to display the nodes of all events in the network. Uncheck to hide 
all event nodes. 

Show related events: Check to display only the nodes of events linked by contributor to 
the selected event. Show all events must be unchecked. 

Edge Display 

Show all contributors: Check to display the lines of all contributors in the network. 
Uncheck to hide all contributors. 

Show related contributors: Check to display only the lines of contributors to the selected 
event. Show all contributors must be unchecked. 

 

Figure 10: Network graphic with ‘show related event names’ display option selected 

Custom Colours and Visibility 

You can customise the display of individual nodes. Click on a node while holding down 
the ALT key (also called OPTION key on Mac). From the pop-up window you can: colour 
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the node by selecting from the palette, remove a custom colour you have previously 
applied, and temporarily hide the node and its lines.  

You can adjust the display of custom colours and hidden elements from the sidebar. 

Show Custom Colours: Check to display the custom colours applied to nodes. Uncheck to 
view the default colours of hide the custom colours, uncheck the box. To remove all 
custom colours permanently click the corresponding Reset button. 

Show Hidden Elements: Check to see elements that are individually hidden. Uncheck to 
hide all elements that are individually hidden. You can also use the corresponding Reset 
button to remove all customized hiding of elements. 

Save 

Download the network in GraphML format for viewing in a network visualisation 
application such as Gephi or Visone. The file will include all information in the 
network, regardless of the current display options. Information on how to view 
exported graph data is provided later in this manual. 

Network 

 

View information about the event 
network under the Network tab in the 
sidebar. 

Centre: The event at the centre of the network. Click on the Centre button to select 
the event. Click on the event name to link to the AusStage record. 

Events: The number of events in the network, including the central event.  

Contributors: The number of contributors in the network. 
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Event Details 

 

Information about a selected event is displayed in 
the sidebar. 

Click on an event’s node in the network graphic to 
view information about the event. 

Click on the triangle next to the event’s name in the 
sidebar to view the list of contributors to that event. 

Click on the event name in the sidebar to link to the 
event record in AusStage.  

Click on a contributor’s name in the sidebar to link to 
the contributor record in AusStage. 

 

Contributor Details 

 

 

Information about a selected contributor is displayed 
in the sidebar. 

Click on a contributor’s line in the network graphic to 
view information about the contributor. 

Click on the triangle next to the contributor’s name in 
the sidebar to view the contributor’s list of events. 

Click on the contributor’s name in the sidebar to link 
to the contributor record in AusStage.  

Click on an event name in the sidebar to link to the 
event record in AusStage. 
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Navigating Networks: Export Graph Data 

Export graph data for use in stand-alone network visualisation and analysis 
applications, such as Visone and Gephi.  

You can export graph data as you browse networks. You can also use the interface 
at http://beta.ausstage.edu.au/networks/export.jsp to export graph data (Figure 12). 

 

Figure12: Export Graph Data interface 

Export Contributor Network 

If you know the contributor identifier: 

1. Enter the id in the Contributor Id field.  

2. Click the Lookup button situated to the right of the Contributor Name field, this 
checks that the contributor id relates to a contributor and you should see the 
contributors name appear in the Contributor Name field.  

If you don't know the contributor identifier:  

1. Click on the Lookup button situated to the right of the Contributor Name field. 
A popup window appears with a single field for Contributor Name.  

2. Enter the name of the contributor you wish to graph and click the Search 
button. After a few moments the window will show matching results.  

3. Click the Choose button relating to the contributor you wish to graph. The 
popup window will disappear, and both the Contributor Id and Contributor 
Name fields will be populated.  

After selecting your contributor:  

1. Select the desired data format from the drop down list. The data format you 
choose should depend on the software you are using to visualize the graph. 
GraphML is compatible with Gephi and Visone.  
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2. Choose the desired radius of your graph. This relates to how many edges are 
between the central node (the contributor) and the outlying nodes at the edge 
of the network. For instance, a radius of 2 will give you a network of all the 
people your selected contributor has worked with, and all the people they 
have worked with.  

3. Click the Export button and in a few moments the file will be downloaded to 
your computer. The file is named ausstage-graph-contributorId-degrees-
numOfDegrees.graphml where contributorId is the contributor id you 
selected and numOfDegrees is the radius you selected.  

Export Event Network 

If you know the event identifier:  

1. Enter the id in the Event Id field.  

2. Click the Lookup button situated to the right of the Event Name field, this 
checks that the contributor id relates to a contributor and you should see the 
contributors name appear in the Event Name field.  

If you don't know the event identifier:  

1. Click on the Lookup button situated to the right of the Event Name field. A 
popup window appears with a single field for Event Name.  

2. Enter the name of the event you wish to graph and click the Search button. 
After a few moments the window will show matching results.  

3. Click the Choose button relating to the event you wish to graph. The popup 
window will disappear, and both the Event Id and Event Name fields will be 
populated.  

After selecting your event:  

1. Select the desired data format from the drop down list. The data format you 
choose should depend on the software you are using to visualize the graph. 
GraphML is compatible with Gephi and Visone.  

2. Choose the desired radius of your graph. This relates to how many edges are 
between the central node (the event) and the outlying nodes at the edge of 
the network.  

3. Choose Simplify True or False. For Simplify True, we only retrieve the events 
at the second degree if they involved contributors to the central event. For 
Simplify False, we retrieve all events at the second degree that involve 
contributors from events at the first degree. 

4. Click the Export button and in a few moments the file will be downloaded to 
your computer. The file is named Evt-eventId-D-radius-simplify.graphml 
where eventId is the event id you selected, radius is the number of degrees 
you selected at radius, and simplify is either S for simplify (Simplify True) or C 
for complex (Simplify False).  
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Mac users  

If you are using Chrome or Safari on a Mac computer to download the Network Data 
you will need to remove the .xml extension that is automatically added to the file by 
the browser. The best way to do this is to right-click on the file, and select Get Info 
from the popup menu. In the info window, scroll down to Name & Extension. Remove 
the .xml extension from the file name.  

About GraphML 

GraphML defines the topology of a graph by declaring its nodes and edges. In 
addition to this, application related information of simple type for the elements of the 
graph can be specified through the extension GraphML-Attributes 
(http://graphml.graphdrawing.org/primer/graphml-primer.html#Attributes). To look into 
the capability of the network analysis and visualization software (Network Workbench 
1.0, Visone 2.6.2 and Gephi 0.7 beta) in regards to their support for GraphML format 
– attribute in particular, a simple actors’ network in GraphML format is prepared and 
examined in the software mentioned above.  

Actors’ Network in GraphML Format 

To illustrate the GraphML with attribute support, a sample GraphML described a 
simple actors’ network with 3 nodes and 2 edges is prepared.  

In this actors’ network, actors are defined as nodes. The contributor ID is defined as 
node id. Each node has 3 attributes. They are FirstName, LastName and Gender 
respectively. Edge is defined from source node to target node. It represents the 
events two actors have worked on. Each edge has 2 attributes. They are 
NumOfEvents which represents edge weight and DateRange.  

Details are reflected in the sample in  

 

 

 

 

 

Figure 13. 



 

 

 

 

 

 

 

 

Figure 13: Sample GraphML output 

Graph Visualisation Programs 

Before you can view any of the exported data, you will need to download and install 
one of the following graph visualisation programs.  

• Gephi: Open-source network visualization software. 
http://gephi.org/users/download/  

• Visone: Java based network visualization software. The Visone web starter is 
the recommended way to run Visone. Each time you run the web starter, it 
will check for updates and install them before running Visone. 
http://visone.info/  

Using the Graph Data 

Gephi 

The following guide assumes you have completed the following:  

1. Downloaded and Installed Gephi  

2. Used the Export Graph Data page to download a set of network data in 
.graphml format.  

3. If you are not already familiar with Gephi, it is advised you work through some 
of the tutorials available in order to get the most out of visualizing your 
network data.  

The following steps will guide you through loading your network data into Gephi.  

1. Locate and run Gephi on your computer.  

2. A dialogue box will appear offering you the following options  
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o Open Recent  

o New Project  

o Samples  

3. Select Open Graph File under the New Project heading  

4. Another dialogue box will appear titled Open. Change the File Format to 
GraphML Files (*.graphml).  

5. Using the Open dialogue box, locate and select the .graphml file you wish to 
visualize. Then click the Open button.  

6. Another dialogue box will appear titled Import report. Click the OK button  

7. Your network data should now be displayed within Gephi as a visualisation.  

Adding two networks to the same visualisation  

Once you have imported one set of data into the visualisation you may wish to add 
another data set to the visualisation. This can be done very simply using the following 
steps.  

1. With your current project in Gephi displayed, go to the File Menu and select 
Open  

2. Locate the other .graphml file you wish to model.  

3. Click Open.  

4. The Import report dialogue box will appear.  

5. In the bottom right hand corner of this box will be two options  

o Add full graph  

o Append graph  

6. Ensure Append graph is selected.  

7. Click OK  

8. The additional data should now be displayed in the visualisation.  

Visone 

The following guide assumes you have completed the following:  

1. Downloaded and run the Visone Java Web Starter  

2. Used the Export Graph Data page to download a set of network data in 
.graphml format.  
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3. If you are not already familiar with Visone, it is advised you read through the 
documentation available in order to get the most out of visualizing your 
network data.  

The following steps will guide you through loading your network data into Visone  

1. Locate and run visone.jnlp on your computer.  

o Depending on your operating system, you may get a message similar 
to the following: The application "Visone" from "visone.info" is 
requesting access to your computer. The digital signature could not be 
verified.  

If this occurs, check the box that will allow this in future and click the Allow 
button  

2. Once Visone has loaded, go to the File menu and select Open.  

3. The Open dialogue box will appear. Use this to locate and select the .graphml 
file you wish to visualize.  

4. Click the OK button in the Open dialogue box.  

5. Your network data will then be loaded into Visone as a visualisation.  

Please Note: Visone initially loads this data very simply, so you may on first load see 
just one coloured box. Using the visualization and layout parameters within Visone 
will alter the visualisation.  

Adding two networks to the same visualisation  

Once you have imported one set of data into the visualisation you may wish to add 
another data set to the visualisation. This can be done very simply using the following 
steps.  

1. With your current project in Visone displayed, go to the File Menu, select Open  

2. Locate the other .graphml file you wish to model.  

3. Click Open.  

4. You will see Visone has created a separate visualization.  

5. Go to the Edit menu and select Select All  

6. Also in the Edit menu select Copy  

7. Return to your original visualization by clicking it's title listed above the 
visualization window.  

8. Go to the Edit menu and select Paste.  

9. Both networks are now in the same visualization space for manipulation.  
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Navigating Networks: Application Programming Interfaces 

Basic Search API 

The basic search API allows for searches to be undertaken of the dataset it is used 
primarily to provide search capabilities via AJAX for other parts of the Navigating 
Networks Service such as the Graph Export page.  

Base URL  

The base URL for the Lookup API is http://beta.ausstage.edu.au/networks/search?  

Request Type 

Get Request  

Available Parameters 

Name  Possible Values  Optional Default  

task  collaborator  No   

query  search terms  No   

sort  name  Yes  name  

format  json  Yes  json  

limit  integer between 5 and 25  Yes  5  

callback  function name to use for a JSONP request Yes   

Parameter Definitions 

Task: collaborator 

Undertake a collaborator search  

Query 

A list of search terms. Currently the search is a case insensitive substring match 
using the collaborator name  

Sort: name 

Sort the search results in name order  

Format: json 
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Format the search result as a JSON array  

Limit: the number of results to return 

A maximum limit of 25 is imposed by the API as a way to reduce resource 
consumption and to reinforce that the search API is designed to be supplementary to 
other discovery mechanisms that will be made available in the future.  

Callback: the name of the callback function 

When data is requested using the JSON format the callback parameter specifies the 
function name to use for a JSONP request.  

Sample Output 

[{ 
 "id":414726, 
 "functions":["Properties Master"], 
 "name":"Anni Archer", 
 "familyName":"Archer", 
 "collaborations":1, 
 "givenName":"Anni", 
 "url":"http:\/\/www.ausstage.edu.au\/indexdrilldown.jsp?xcid=59&f_contrib_id=414726" 
 }, 
 { 
 "id":253687, 
 "functions":["Actor"], 
 "name":"Brett Archer", 
 "familyName":"Archer", 
 "collaborations":3, 
 "givenName":"Brett", 
 "url":"http:\/\/www.ausstage.edu.au\/indexdrilldown.jsp?xcid=59&f_contrib_id=253687" 
 } 
] 

Protovis API 

The Protovis API provides the functionality export data in a format that can be used 
with the Protovis visualisation library.  

The details of the API are as follows:  

Base URL 

The base URL for the Lookup API is http://beta.ausstage.edu.au/networks/protovis?  

Combining this URL with the parameters outlines below retrieves data from the 
Navigating Networks Dataset.  

Available Parameters 

Name  Possible Values  Optional Default  

task  ego-centric-network / event-centric-network No   

id  unique contributor id / event id  No   
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radius  Integer between 1 and 3  Yes  1  

simplify  Boolean  Yes  true  

callback  function name to use for a JSONP request Yes   

task 

The task parameter defines the type of export that is undertaken. Currently two tasks 
are available. They are ego-centric network and event-centric-network.  

id 

The id parameter defines the unique identifier of the contributor or event that is of 
interest.  

radius 

The desired number of edges between the central node and the peripheral nodes of 
the network.  

simplify 

This parameter is only valid with event to event 2nd degree network (task = event-
centric-network && radius = 2 )  

simplify = true : with each of the 1st degree nodes, only events for those contributors 
involved in the central node are retrieved.  

simplify = false: with each of the 1st degree nodes, events for all contributors are 
retrieved.  

callback 

When data is requested using the JSON format the callback parameter specifies the 
function name to use for a JSONP request.  

Sample Output 

The following is abbreviated sample output in response to the following API call:  

http://beta.ausstage.edu.au/networks/protovis?task=ego-centric-network&id=414321  

{ 
  "edges": [ 
    { 
      "firstDate": "1989-07-27", 
      "source": 1, 
      "target": 7, 
      "lastDate": "2001-11-04", 
      "value": 14 
    }, 
    { 
      "firstDate": "2001-10-21", 
      "source": 1, 
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      "target": 16, 
      "lastDate": "2008-05-24", 
      "value": 2 
    }, 
    { 
      "firstDate": "2005-07-18", 
      "source": 1, 
      "target": 19, 
      "lastDate": "2005-07-20", 
      "value": 1 
    }, 
    { 
      "firstDate": "2000-03-02", 
      "source": 1, 
      "target": 20, 
      "lastDate": "2000-03-02", 
      "value": 1 
    }, 
    ... 
    { 
      "firstDate": "2010-08-05", 
      "source": 114, 
      "target": 115, 
      "lastDate": "2010-08-21", 
      "value": 1 
    } 
  ], 
  "nodes": [ 
    { 
      "id": "414321", 
      "functions": [ 
        "Actor" 
      ], 
      "nodeUrl": "http:\/\/www.ausstage.edu.au\/indexdrilldown.jsp?xcid=59&amp;f_contrib_id=414321", 
      "nodeName": "Brad Williams" 
    }, 
    { 
      "id": "533", 
      "functions": [ 
        "Director", 
        "Set designer", 
        "Designer", 
        "Costume Designer" 
      ], 
      "nodeUrl": "http:\/\/www.ausstage.edu.au\/indexdrilldown.jsp?xcid=59&amp;f_contrib_id=533", 
      "nodeName": "Tim Maddock" 
    }, 
    { 
      "id": "611", 
      "functions": [ 
        "Playwright", 
        "Director", 
        "Assistant Director" 
      ], 
      "nodeUrl": "http:\/\/www.ausstage.edu.au\/indexdrilldown.jsp?xcid=59&amp;f_contrib_id=611", 
      "nodeName": "Cath McKinnon" 
    }, 
    ... 
    { 
      "id": "440145", 
      "functions": [ 
         
      ], 
      "nodeUrl": "http:\/\/www.ausstage.edu.au\/indexdrilldown.jsp?xcid=59&amp;f_contrib_id=440145", 
      "nodeName": "Bevan Emmett" 
    } 
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  ] 
} 

Export API 

The export API provides the functionality to export data out of the Navigating 
Networks Dataset in a variety of different formats.  

The details of the API are as follows:  

Graph Export 

Base URL 

The base URL for the Lookup API is http://beta.ausstage.edu.au/networks/export?  

Combining this URL with the parameters outlines below retrieves data from the 
Navigating Networks Dataset.  

Request Type 

Get Request  

Available Parameters 

Name  Possible Values  Optional Default 

task  ego-centric-network-simple No   

id  unique identifier of a contributor No   

format  graphml, debug  Yes  graphml 

radius  Integer between 1 and 3  Yes  1  

Parameter Definitions 

Task: ego-centric-network-simple 

An ego centric network that has basic information included the central point of the 
network is the contributor with the supplied id.  

Format: graphml 

This export format uses the GraphML data format and includes edges and nodes.  

Format: debug 

This export format provides a text based representation of the internal data structures 
used by the service while compiling the graph. The format is as follows:  
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id – list of collaborators – number of collaborators in the list  

For example:  

111 – 101, 102, 1324, 56789 – 4  

Radius 

The desired number of edges between the central node and the peripheral nodes of 
the network  

Sample Output 

Graphml Format 

<?xml version="1.0" encoding="utf-8" standalone="no"?> 
<graphml xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
  xsi:schemaLocation="http://graphml.graphdrawing.org/xmlns 
http://graphml.graphdrawing.org/xmlns/1.0/graphml.xsd" 
  xmlns="http://graphml.graphdrawing.org/xmlns"> 
  <!--Graph generated on: ... --> 
  <!--Graph generated by: ... --> 
  <graph edgedefault="directed" id="ausstage-graph"> 
    <node id="2"/> 
    <node id="10141"/> 
    <edge source="2" target="10141"/> 
    <node id="1021"/> 
    <edge source="2" target="1021"/> 
    <node id="10222"/> 
    <edge source="2" target="10222"/> 
    <node id="105"/> 
    <edge source="2" target="105"/> 
    <node id="110"/> 
    <edge source="2" target="110"/> 
    <node id="133"/> 
    <edge source="2" target="133"/> 
    <node id="1340"/> 
    <edge source="2" target="1340"/> 
    <node id="1352"/> 
    <edge source="2" target="1352"/> 
    <node id="1356"/> 
    <edge source="2" target="1356"/> 
    ... 
       <edge source="415544" target="415995"/> 
    <edge source="415993" target="415995"/> 
    <edge source="425776" target="425777"/> 
    <edge source="427679" target="430163"/> 
    <edge source="430163" target="430713"/> 
    <edge source="430163" target="431299"/> 
    <edge source="430713" target="431299"/> 
    <edge source="430918" target="440026"/> 
    <edge source="430918" target="440027"/> 
    <edge source="432105" target="432106"/> 
    <edge source="432444" target="432445"/> 
    <edge source="432444" target="432446"/> 
    <edge source="432445" target="432446"/> 
    <edge source="440026" target="440027"/> 
  </graph> 
</graphml> 
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Edge List Export 

Note, that this export format exports the entire list of relationships in the dataset. This 
results in a large file that may take some time to process and download. It is highly 
recommended that this API be used sparingly and be used on a fast broadband 
connection.  

Alternative static snapshots of this data may be downloaded from the downloads 
section of this website. These static snapshots are only updated on request.  

Base URL 

The base URL for the Lookup API is http://beta.ausstage.edu.au/networks/export?  

Request Type 

Get Request  

Available Parameters 

Name  Possible Values  Optional  Default 

task  

full-edge-list-with-dups, full-edge-list-no-dups, full-
edge-list-with-dups-id-only, full-edge-list-no-dups-id-
only  
 
actor-edge-list-with-dups, actor-edge-list-no-dups, 
actor-edge-list-with-dups-id-only, actor-edge-list-no-
dups-id-only 

No   

Parameter Definitions 

Task: full-edge-list-with-dups 

A full export of the dataset in the edge list format containing duplicate 
relationships.  

Task: full-edge-list-no-dups 

A full export of the dataset in the edge list format that does not contain 
duplicate relationships.  

Task: full-edge-list-with-dups-id-only 

A full export of the dataset in the edge list format that contains ids only.  

Task: full-edge-list-no-dups-id-only 

A full export of the dataset in the edge list format that does not contain 
duplicate relationships and that contains ids only.  

Task: actor-edge-list-with-dups 
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An export of the dataset in the edge list format containing duplicate relationships 
between contributors with a function of "actor" or "actor and singer".  

Task: actor-edge-list-no-dups 

An export of the dataset in the edge list format that does not contain duplicate 
relationships between contributors with a function of "actor" or "actor and singer".  

Task: actor-edge-list-with-dups-id-only 

An export of the dataset in the edge list format that contains ids only between 
contributors with a function of "actor" or "actor and singer".  

Task: actor-edge-list-no-dups-id-only 

An export of the dataset in the edge list format that does not contain duplicate 
relationships and that contains ids only between contributors with a function of "actor" 
or "actor and singer".  

Sample Output 

Full edge lists 

id \t given_name \t family_name \t id \t given_name \t family_name \n 

Full edge lists (id only) 

id \t id \n 

Actor edge lists 

id \t given_name \t family_name \t gender \t id \t given_name \t family_name \t 
gender \n 

Actor edge lists (id only) 

id \t id \nnn 


